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If there’s one digital tool I rely on as much as Gmail, it’s Google Calendar.

From work deadlines to family happenings and random reminders, Calendar is what 
keeps me on track, on time, and on top of the approximately 1.7 zillion things I tend to 
juggle on an hourly basis. And the more I’ve used it, the more I’ve learned just how flex-
ible it is—and how many easily overlooked options it offers for enhancing its interface, 
getting stuff accomplished more efficiently, and making the service work in whatever 
way makes sense for my own personal workflow.

If you rely on Google Calendar like I do—or even if you just use it casually to keep track 
of occasional appointments—you’ll get more out of it once you’ve discovered all of its 
advanced tricks and time-saving possibilities. And if you’re too busy to tackle this right 
now, no worries: I happen to know a spectacular tool for setting reminders and making 
sure you never forget anything on your agenda.

(Unless otherwise noted, all the instructions mentioned below are specific to Calendar’s 
web version.)

INTERFACE ENHANCEMENTS

1. Wish your calendar could show a little more info—with less wasted space? Google 
Calendar has a hidden option to increase its display density. Click the gear icon in the 
website’s upper-right corner, then select “Density and color” and change the “Informa-
tion density” setting to “Compact” to try it.

2. If most of your appointments tend to be during the week, you can also tidy up your 
view by telling Calendar to stop showing weekends. You’ll find the toggle by clicking 
the view dropdown—the box directly to the right of the gear icon on the Calendar web-
site—and looking at the bottom of the menu that appears.

3. Even if you want to see weekends, you might prefer to show your weeks starting 
with Mondays and ending with the weekend—the way most of us think of a traditional 
workweek. You can make that change with a couple of quick clicks by opening the “View 
options” section of the Calendar site’s settings.

4. Google Calendar can let you create your own custom view in addition to the standard 
day, week, month, and year arrangements—if, say, you want to view your calendar in a 
zoomed-in two-day perspective or maybe a zoomed-out two- or four-week layout. Open 
the site’s settings, click “View options” in the left-of-screen sidebar, and then adjust the 
“Set custom view” option to set it up however you like.
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5. Having multiple calendars in your account can often be useful, whether you’re sepa-
rating holidays, shared family events, or any number of shared work-related agendas. 
But some calendars aren’t important enough to be seen all the time—so let Calendar 
hide low-priority calendars by default and then show them only when you need them. 
In the left-of-screen sidebar on the Calendar website, uncheck the box next to any calen-
dar you don’t want displayed. That’ll keep it out of sight and clean up your active view, 
and you can then just recheck the calendar in question when you want it to appear.

6. Conversely, Calendar can show you a single calendar at a time for a slimmed-down and 
easily digestible arrangement. Click the three-dot menu icon next to any calendar’s name 
in that same left-of-screen sidebar area, then select “Display this only” to give it a whirl.

7. Clear out clutter and give your calendar more space to spread out by hiding Google 
Calendar’s sidebars whenever you aren’t using them. On the left side of the screen, click 
the three-line menu icon at the top to collapse the sidebar (and then click that same icon 
to expand it as needed). On the right—the sidebar that lets you view your Google Keep 
notes and other connected services—click the small left-facing arrow at the bottom to 
make that area vanish (and then click the right-facing arrow that appears if and when 
you want to bring the panel back).

8. Manage appointments across multiple time zones by activating Calendar’s second-
ary time zone option, which gives you the ability to have events start or end in different 
time zones and avoid any confusion or need for on-the-fly mental conversions. Look for 
the “Time zone” header in the website’s settings, then check the box next to “Display sec-
ondary time zone” and select what time zone you want. You can also give each time zone 
a label (“Boston” and “California,” for example) to make things even simpler.

9. Calendar can also show you a world time clock to give you an at-a-glance view of the 
current time in any number of places. Look for the “World clock” option in the website’s 
settings; once it’s activated, you can add however many time zones you want, and they’ll 
all be displayed in the left-hand sidebar. 

TIME-SAVING TOOLS

10. Switch your calendar view in an instant by tapping into one of Google Calendar’s 
super-handy hidden shortcuts: Press “1” or “d” for the day view, “2” or “w” for the week 
view, “3” or “m” for the month view, “4” or “x” for your custom view, “5” or “a” for the 
agenda view, and “6” or “y” for the year view

11. One of Calendar’s best hotkeys is also one of the easiest ones to overlook: Press “g” 
from any calendar view to jump directly to any specific date, in any year. Calendar will 
pop up a box in which you can simply type whatever date you want, using either a stan-
dard date format (“4/13/06”) or a text-based description (“April 13, 2006”).

12. Another shortcut worth remembering: From anywhere on the Calendar site, hit the 
Esc key to jump back to the main calendar screen in a jiff. And while looking at any 
calendar view, hit “t” to return to today’s date.

13. While in Calendar’s day, week, or month view, you can left-click on any event for a fast 
pop-up view of its details—or right-click to access quick event adjustment options, 
including a selector to switch the event’s color and a one-click button to delete the event 
entirely right then and there.
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14. Google Calendar’s search function is a great way to find an event in a hurry, and it 
has more options than you’d think: After clicking the search icon at the top of the Calen-
dar site, click the downward-facing arrow in the search box that appears. That’ll reveal 
an advanced search panel that lets you narrow a search down to specific calendars, 
dates, locations, or participants—and even search for an event by excluding certain 
keywords.

15. Calendar has a little-known command that’ll let you undo errant actions—like mov-
ing an event by mistake or deleting the wrong appointment. As soon as such an instance 
arises, hit Ctrl-Z or even just “z” by itself on your keyboard. You have only about a 10-sec-
ond window to do it, annoyingly, but if you catch your slipup soon enough, it’s a great 
way to fix your flub.

16. For times when you delete an event entirely and then need to get it back later, don’t 
forget about Google Calendar’s tucked-away Trash section. It gives you the opportunity 
to recover any deleted event for a month after its axing. You can find the Trash section 
by clicking the gear icon in the site’s upper-right corner and selecting the “Trash” option 
in the menu that appears.

17. Need to create an event that’s almost exactly like one already present on your calen-
dar? Google Calendar has a hidden option to duplicate an event and use it as a blue-
print for a new calendar entry. Just open up the event you want to use as the model, 
then click the “More actions” button in the upper-right corner of the screen. There, you’ll 
find the convenient command to duplicate the event and start a fresh one with its de-
tails prefilled and ready for editing.

EVENT ENRICHMENTS

18. Did you know you can add an attachment directly to an event within Calendar—
something like a PDF, image file, or document that you want all the invitees to see? When 
creating a new event, look for the paper clip icon in the toolbar atop the description field. 
Clicking it will allow you to insert any file from your local device or your Google Drive 
storage.

19. When you need to send a message to everyone invited to a particular event, save 
yourself the trouble of opening up your inbox and instead just email all of your event 
invitees directly from Calendar. While viewing any event that has at least one other 
person involved, you’ll see a small envelope icon under the “Guests” header on the right 
of the screen. Click that icon, and you can compose and send your message right within 
that window, directly from the Gmail address associated with your account.

20. If you create a group event but then end up needing to back out of attending, Calen-
dar has a way to let you transfer event ownership so the event can continue in your 
absence. Open up the event from the Calendar website, click the “More actions” button 
in the upper-right corner of the screen, and select “Change owner” from the menu that 
appears. Then, you can type in the name or address of whomever you want to take over 
as the primary point of contact.

21. By default, new events in Google Calendar last for an hour and include alerts 30 min-
utes before their scheduled start times—but you can customize both those settings and 
give events any default duration and notification schedule you like. To change your 
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default duration, look in the “Event settings” section of the Calendar site’s settings and 
find the aptly named “Default duration” option. The default notification time, mean-
while, can curiously be changed only in the Calendar mobile app: On Android or iOS, 
find the section specific to your Google account within the app’s settings and tap on 
“Events,” then adjust the “Default notifications” settings as needed.

22. Got something that needs to be on your agenda on a regular, repeating interval? Cal-
endar can handle recurring events and reminders with some impressively custom-
izable parameters. While creating a new event or reminder, click the box labeled “Does 
not repeat” (beneath the date and time and to the right of the “All day” option). That’ll 
give you a list of preconfigured patterns—having the item repeat daily, weekly on the 
current day, monthly on the current day, and so on—along with an option called “Cus-
tom” that lets you get incredibly specific about exactly how, when, and for how long you 
want your item to recur.

ADVANCED ALERTS

23. In addition to the usual notifications on the desktop and on your phone, you can ask 
Calendar to send you an email notification for any event. That can be especially help-
ful if you spend a lot of time in your inbox and want to have a reminder that remains 
present until you archive it. To create an email reminder for an event, open the event and 
then click the “Add notification” command. Next, within the new line that appears, click 
the “Notification” box and change it to “Email”—then just tell Calendar how far ahead of 
the event you want the email to arrive. Be sure to hit the blue “Save” button at the top of 
the screen when you’re done.

24. If you want to get email alerts for all events by default, open up Calendar’s settings 
and select your calendar from the list on the left side of the screen. Scroll down to the 
“Event notifications” section and click the “Add notification” button. Click on the new 
“Notification” box that appears, change it to “Email,” and set it for whatever amount of 
time you’d like.

25. You can also change your default alert times for regular Calendar notifications 
in that same area of the site’s settings: Just adjust the number of minutes next to the 
existing notifications under the “Event notifications” and “All-day event notifications” 
headers. You can add additional notifications, too, or remove any existing notifications 
by clicking the “x” alongside them.

26. Want to get a daily rundown of your Calendar agenda via email every morning? 
Look under the “General notifications” header within that same section of the site’s set-
tings. Find the line labeled “Daily agenda,” then click the box next to it that says “None” 
and change it to “Email.” Your new daily summary will now arrive at 5:00 every morn-
ing, courtesy of the virtual calendar genie who’s been waiting for your wish all this time.

FASTCOMPANY.COM  6

135 INCREDIBLY USEFUL THINGS     
 YOU DIDN’T K NO W GOOGLE COULD DO

26 INCREDIBLY USEFUL THINGS YOU DIDN’T KNOW GOOGLE CALENDAR COULD DO



I’ll admit it: For the majority of my adult life, spreadsheets have remained shrouded in 
mystery. I’ve used them plenty, of course–to track income, compare statistics, even main-
tain databases for various types of work-related info–but I’ve always felt like I’ve barely 
been scratching the surface of what they’re able to do.

And that’s a shame. With Google Sheets in particular, sticking only to spreadsheet basics 
seems akin to sitting on a mountain of untapped potential. The service has a profusion of 
advanced functions, options, and shortcuts, but until you identify and internalize them, 
you’re getting only a fraction of the value it can provide.

So after all these years, I decided to take action. I dug deep into Sheets’ darkest nooks 
and crannies to uncover some of its most useful and easily overlooked features. Whether 
you’re a casual spreadsheet explorer or a more ambitious data-crunching pro, I’d be will-
ing to wager there are plenty of worthwhile possibilities just waiting for you to discover, 
too.

Read on, and get ready to take your Google Sheets experience to a whole new level.

(While some of these items will also work in the Sheets’ mobile apps, the instructions 
below are all for the service’s web version.)

SAVE TIME WITH SHORTCUTS

1. The next time you need to create a new spreadsheet, save yourself the trouble of open-
ing up the main Google Sheets site and clicking through the commands there. Instead, 
just type “sheet.new” directly into your browser’s address bar. As long as you’re already 
signed into your Google account, that’ll start a new spreadsheet for you, no matter where 
you are on the web. (You can also type “sheets.new” or “spreadsheet.new,” if you prefer.)

2. Sheets has plenty of keyboard shortcuts, but one series that’s especially worth noting 
is the collection of commands that quickly insert the current date and/or time wherever 
you want: Hit Ctrl or Cmd and the semicolon key to add the date, Ctrl or Cmd along with 
Shift and the semicolon key to add the time, and Ctrl or Cmd along with Alt and Shift and 
the semicolon key to add the date and time together.

3. Google Sheets’ fast-formatting shortcuts are also worth remembering. With the right 
combination of keys, you can format any cell or selection of cells however you want, 
without having to dig around in menus. Commit these to memory:

BY JR RAPHAEL

27 incredibly useful things 
you didn’t know Google 
Sheets could do

FASTCOMPANY.COM  727 INCREDIBLY USEFUL THINGS YOU DIDN’T KNOW GOOGLE SHEETS COULD DO

135 INCREDIBLY USEFUL THINGS     
 YOU DIDN’T K NO W GOOGLE COULD DO

“ I  D U G  D E E P 
I N T O  S H E E T S ’ 

D A R K E S T  N O O K S 
A N D  C R A N N I E S  T O 

U N C O V E R  S O M E 
O F  I T S  M O S T 

U S E F U L  A N D  E A S I LY 
O V E R L O O K E D 

F E AT U R E S .”



Ctrl-Shift-1: Format as decimal

Ctrl-Shift-2: Format as time

Ctrl-Shift-3: Format as date

Ctrl-Shift-4: Format as currency

Ctrl-Shift-5: Format as percentage

Ctrl-Shift-6: Format as exponent

4. You can even create your own personalized shortcut within Sheets to perform a com-
plex series of custom actions with a single command. Open the Tools menu, select “Mac-
ros,” and then select “Record macro.” If you want the shortcut to always be performed on 
the same specific cells, select “Use absolute references”; otherwise, select “Use relative 
references.” Then perform whatever actions you want to record.

You could do something like set a specific sort of formatting for a cell’s contents (bolded 
white text with the Open Sans font and a dark-gray background, for instance) or you 
could manipulate data in a more involved manner, like copying a cell’s contents and 
then erasing that cell and pasting the contents one cell over to the left. When you’re fin-
ished, click the “Save” button in the macro-recording panel, and you’ll be able to give 
your new shortcut a name and assign it to any available key combination for future 
activation.

GRAB SOME DATA

5. Need to show some live data from one spreadsheet inside another? Copy the full 
URL of the sheet with the data and paste it into Sheets’ IMPORTRANGE function, 
using the following format (with your own URL, sheet number, and cell range in 
place):

=IMPORTRANGE(“https://docs.google.com/spreadsheets/d/1aBcDEfgHiJKLM-
nOPQRSTuVWXZ”, “Sheet1!D1:D15”)

Then just paste that function into the sheet where you want the data to appear. You’ll 
have to hover over the cell and click a button to allow the two sheets to be connected, 
and then–hocus-pocus!–all of the data from your other sheet will magically appear and 
remain current whenever any changes are made.

6. Sheets can pull in data from any publicly available web page, too, as long as the page 
has a properly formatted table. The secret lies within the IMPORTHTML command; use 
it with whatever URL you need and the number indicating which table on the page you 
want to import (“1” for the first table, “2” for the second, and so on):

=IMPORTHTML(“https://en.wikipedia.org/wiki/List_of_sandwiches”,”table”,1)

And just like that, all of the info will appear within your spreadsheet. 

7. A similar kind of command can let you import recent entries from a website’s RSS 
feed into any spreadsheet. All you need to do is enter the IMPORTFEED command along 
with the URL of the feed you want—so, for instance, if you wanted to see all of my Fast 
Company stories in Google Sheets, you could enter:

=IMPORTFEED(“https://fastcompany.com/user/jrraphael/rss”)
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If you wanted only the titles of the stories—and wanted only, say, the most recent five 
entries—you could add in the following parameters:

=IMPORTFEED(“https://fastcompany.com/user/jrraphael/rss”,”items title”,false,5)

And then if you wanted to place the links to each story in a separate column alongside 
that, you could use this:

=IMPORTFEED(“https://fastcompany.com/user/jrraphael/rss”,”items URL”,false,5)

8. Google Sheets has an easily overlooked cousin called Google Forms that lets you col-
lect data in a survey-style form on the web and then compile the results in a spreadsheet. 
You can create a form by looking for the “Forms” option within Sheets’ Insert menu, 
and then using the site that comes up to create any set of questions and parameters 
you want. When your form is ready, click the “Send” button in the upper-right corner of 
the page to email it to anyone, embed it in a web page, or get a manual link for sharing 
it however you like. As responses come in, they’ll automatically appear in your spread-
sheet as their own individual rows.

CLEAN IT UP

9. If you spot some extra spaces before or after data in your spreadsheet (whether you’re 
looking at numbers or text), don’t forget the Google Sheets function TRIM. You can type 
it in for whatever cell you want–=TRIM(A1), for instance–and it’ll take away any leading 
or trailing spaces and give you a cleaner version of the cell’s value.

If you want to perform the function for multiple cells at once, use this format for what-
ever range you need:

=ArrayFormula(TRIM(A2:A50))

10. Looking at lots of data with RanDoM or ImPropeR CaPitaLiZaTion? Sheets can stan-
dardize case formatting for you with a few simple functions: UPPER(A1) will make all of 
the text uppercase for whatever cell you mention; LOWER(A1) will do the same with low-
ercase; and PROPER(A1) will capitalize the first letter of each word for a title-case effect.

11. Maybe you have a database of user-submitted email addresses. Well, tell Sheets to 
look through the addresses and determine if they’re all properly formatted: Use the func-
tion ISEMAIL(A1) with whatever cell you need–or if you want to perform the function for 
a range of cells, use this format instead:

=ArrayFormula(ISEMAIL(A2:A50))

Sheets will give you a “TRUE” or “FALSE” answer for every email address you feed it.

12. You can validate URLs in a spreadsheet, too, to make sure you don’t have any improp-
er items in your list: Follow the same procedure outlined in the previous tip but use the 
function ISURL instead.

ANALYZE AND VISUALIZE

13. Perform fast calculations in any number-oriented spreadsheet by highlighting a 
bunch of cells and then looking in the lower-right corner of the screen. By default, Sheets 
will show you the sum of the numbers you’ve selected. You can then click the box with 
that info and tell it to show the average, the minimum or maximum, or the total count of 
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numbers involved–and once you make that change, your selection will stick and remain 
the new default for any future calculations you perform.

14. Create a tiny chart within a single cell using Sheets’ nifty Sparkline feature. Just type 
the command =SPARKLINE followed by the cells you want to include, the word “chart-
type,” and then the type of chart you want to create–such as line, bar, or column–for-
matted like this:

=SPARKLINE(E12:E23,{“charttype”,”column”})

If you really want to get wild, you can even include a variety of customization commands 
that’ll control the colors used in different parts of your chart along with other visual factors.

15. Tap into Google’s artificial intelligence and let Sheets perform different types of data anal-
ysis and create complex charts for you. Hover your mouse over the starburst-shaped icon 
in the lower-right corner of the screen, and you’ll see the word “Explore” appear. Click that 
button, and Sheets will pop up a panel of info related to your data. You can highlight specific 
rows in your spreadsheet to change its focus, and you can hover over any item it presents to 
find options for adjusting it or inserting it directly into your sheet.

FORMAT LIKE A PRO

16. Sheets allows you to hide any row. Click its number in the gray column at the far left of 
the screen and select “Hide row” from the menu that appears. When you want to show the 
row again, click the black arrows that appeared in its place within that same left-of-screen 
column.

17. Want a quick and easy way to make your spreadsheet pop? Look for the “Alternating 
colors” option in Sheets’ Format menu. It’ll give you a simple set of options that’ll apply a 
sharp-looking color pattern to your rows–no thought or effort required.

18. While you’re jazzing up your spreadsheet’s appearance, think about letting Sheets rotate 
the text in your header row. Highlight the row, then click on the icon that shows an angled 
“A” with an up-pointing arrow beneath it (directly to the left of the link-inserting tool). You 
can then pick from several eye-catching effects that’ll set your header text apart and give your 
spreadsheet a snazzy, polished look.

19. Sheets can copy a cell’s complete set of formatting and apply it to another cell with a few 
fast clicks. First, click the cell with the formatting you want to copy. Then, click the paint 
roller icon–directly to the right of the print command, toward the left side of the toolbar–and 
click the cell to which you want the formatting to apply. Everything from the font size and 
color to the cell shading and numerical style will carry over.

20. Give yourself or your team a functional checklist right within a spreadsheet: Select a series 
of blank cells, open the Insert menu, and select “Checkbox.” You can then put your to-do 
items in the next column over and get the satisfaction of checking items off as you complete 
them.

SHARE AND COLL ABORATE

21. Once you’ve shared a spreadsheet–either publicly or with specific people–you can create 
a custom link that’ll let anyone with access quickly copy your spreadsheet into their own 
Google account, where they can use it as a template or modify it however they want without 
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affecting your original version. Just copy the URL in your browser’s address bar while you’re 
viewing the spreadsheet and replace the word “edit” at the end with “copy”—leaving you with 
something like this:

https://docs.google.com/spreadsheets/d/1aBcDEfgHiJKLMnOPQRSTuVWXZ/copy

When anyone with access to the spreadsheet opens that link, they’ll immediately be prompt-
ed to make a copy with a single click right then and there.

22. Sheets makes it easy to export a spreadsheet in a variety of formats via the “Download as” 
option in the File menu, but if you’d rather give people a direct link to download your data 
as a PDF, there’s a hidden command for doing just that: Copy your spreadsheet’s URL, just 
like in the previous item, but this time, replace the word “edit” at the end with “export?for-
mat=pdf ”–leaving you with a link that looks something like:

https://docs.google.com/spreadsheets/d/1aBcDEfgHiJKLMnOPQRSTuVWXZ/export?for-
mat=pdf

People with access to the spreadsheet will instantly be presented with a PDF export as soon 
as they open the link.

23. When you’re sharing a spreadsheet or using a form to accept survey-like responses, you 
can ask Sheets to notify you whenever an edit or addition occurs–either immediately or as a 
once-daily email digest. Look for the “Notification rules” option in the Tools menu to set your 
preferences for any particular spreadsheet.

TRY AN ADVANCED FEATURE OR T WO

24. Sheets has the capability to create QR codes that’ll pull up whatever URLs you want when 
they’re scanned. Type your URL into a cell (with “http://” or “https://” in front of it), then use 
the following function with your own cell number in place of “A2”:

=image(“https://chart.googleapis.com/chart?chs=150×150&cht=qr&chl=”&A2)

The QR code will instantly appear and be available to copy, share, or manipulate in any way 
your heart desires.

25. Here’s a handy little Sheets function for tracking trends across numerical data: Create a 
heat map to highlight highs and lows and make it easy to see things like sales or web-traffic 
success patterns. Select whatever range of data you want, then look for the “Conditional for-
matting” option within the Format menu. Click the “Color scale” tab at the top and assign a 
color to both “Min value” and “Max value.” The effect will work best if you use a light version 
of a color for the former and a dark version of the same color for the latter.

26. Sheets has the power of Google Finance (which–who knew?–is still a thing) baked right 
in for your stock-knowledge needs. The system is able to give you real-time or historical stock 
prices along with all sorts of other market-related data for any publicly traded company. Sim-
ply use the function GOOGLEFINANCE followed by the info you desire, using the variables 
and formats described on this page.

27. Ever find yourself scrolling through a list of responses in different languages? Sheets can 
identify any language used in a spreadsheet and even translate it into your own native tongue 
on the spot. To detect a language, use the following function (with the appropriate cell num-
ber in place of “A1”):
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=DETECTLANGUAGE(A1)

You can also enter in a word in place of a cell number, if you want:

=DETECTLANGUAGE(“queso”)

Google will give you a two-letter code telling you the language that was used. To translate, 
meanwhile, use the following command–with your own word or cell number in place of “A1” 
and the code for whatever language you want to translate into (if it’s anything other than 
English, as referenced below):

=GOOGLETRANSLATE(A1,”auto”,”en”)

Assez facile, non?
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These days, a browser is more than just a basic navigator for the web. It’s effectively a 
second desktop—a gateway to countless apps, sites, and services. And optimizing that 
environment can go a long way in increasing your efficiency.

Google’s Chrome in particular is full of hidden shortcuts, features, and power-user possi-
bilities. Take the time to learn these tips, and watch your productivity soar.

(Note that most of the tips here are specific to the desktop versions of Chrome for Win-
dows PCs and Macs and may not apply to the browser’s mobile variants.)

LEARN SOME HANDY HIDDEN SHORTCUTS

1. Want to open a link into a new tab in the background, so it won’t interrupt what you’re 
doing? Hold down Ctrl- or Cmd- and click it. To open a link in a whole new window, mean-
while, use Shift instead. (This’ll work within most areas of Chrome, by the way—includ-
ing the History page and the dropdown history list within the Back button, which we’ll 
get to in a bit.)

2. You probably know you can press the space bar to scroll down a full page-length, but 
there’s another side to that shortcut: If you press Shift and the space bar together, Chrome 
will do the opposite and scroll up by a full page-length at a time.

3. If you ever close a tab by mistake, hit Ctrl- or Cmd-Shift-T. Chrome will reopen your 
most recently closed tab as if nothing had ever happened. (And you can do it multiple 
times, too, if there’s more than one tab you’d like to recover.)

4. When you have a bunch of tabs open and want to hang onto the entire session for later, 
hit Ctrl-Shift-D. That’ll let you save all your open tabs into a folder for easy future access. 
To restore them, right-click the folder within your bookmarks and select “Open all” or 
“Open all in new window.”

5. Skip a step and get info about any word or phrase in a page by highlighting it and then 
right-clicking and selecting the “Search Google” option. You can also highlight a word or 
phrase and drag it into Chrome’s address bar to achieve the same result—or drag it into 
the area directly to the right of your final tab to launch the search in a new tab instead of 
your current one. (Bonus tip: Those same dragging behaviors can also be used to open 
links.)

6. Save a link with a single click: Just click, hold down your mouse button, and drag the 
link up into Chrome’s bookmarks bar. Drop it wherever you want, and it’ll be there the 
next time you need it.
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7. If you download a file and then want to move it somewhere specific, click on its tile in 
the download bar that appears at the bottom of the browser. You can then drag and drop 
whatever you downloaded directly onto your desktop or into any folder.

8. You can also drag and drop files from Chrome’s download bar directly into an online 
service—like Google Drive, for instant uploading, or Gmail, for inserting the file as an 
attachment in a new message.

9. Should you ever find Chrome mysteriously misbehaving, remember this command: 
chrome://restart. Type it into Chrome’s address bar, and your browser will restart itself 
and restore all your tabs and windows in a jiffy. You never know when it might come in 
handy.

TEACH YOUR BROWSER SOME NE W TRICKS

10. With 60 seconds of setup, you can give Chrome its own quick-access scratchpad that’ll 
let you jot down thoughts right within the browser—no extensions required. All you have 
to do is paste a snippet of code below into Chrome’s address bar. 

…and then save the page to your bookmarks bar for easy access. The scratchpad supports 
text formatting (Ctrl- or Cmd-B for bold, Ctrl- or Cmd-I for italics, and Ctrl- or Cmd-U for 
underlining) and even has a built-in spell check feature. Just open it and start typing—
and if you want to save your thoughts for later retrieval, hit Ctrl- or Cmd-S.

11. Chrome’s custom search engine feature has tons of untapped productivity potential. 
First, you can use it to create simple shortcuts to pages you visit often—anything from 

FASTCOMPANY.COM  14

135 INCREDIBLY USEFUL THINGS     
 YOU DIDN’T K NO W GOOGLE COULD DO

27 INCREDIBLY USEFUL THINGS YOU DIDN’T KNOW CHROME COULD DO



favorite websites to internal Chrome pages or even the scratchpad described in the pre-
vious tip. Just open up Chrome’s settings, click the line labeled “Manage search engines,” 
then click the “Add” command next to the “Other search engines” heading. Type the name 
of the page in the “Search engine” field, the shortcut you want for it in the “Keyword” 
field, and the page’s full URL in the “URL” field.

For instance, if you want to be able to pull up Chrome’s settings simply by typing “cs” into 
your address bar, you could use “Chrome Settings” as the search engine name, “cs” as the 
keyword, and chrome://settings as the URL. To get to your new scratchpad quickly, you 
could use “Scratchpad” as the search engine name, “s” as the keyword, and the full string 
of code from above as the URL.

12. You can also use Chrome’s custom search engines feature to create shortcuts for 
searching any sites you want. The trick is to first find the full URL of the site’s own search 
system—so if you wanted to do it for Fast Company, you’d go to fastcompany.com, click the 
search icon in the upper-right corner of the screen, then search for a word like “test.” The 
site will take you to https://www.fastcompany.com/search/test.

With that knowledge in tow, head back to Chrome’s “Manage search engines” section and 
click the “Add” command. This time, type “Fast Company” in as the search engine name, 
“fastcompany.com” as the keyword, and “https://www.fastcompany.com/search/%s”—
with “%s” taking the place of the actual query—as the URL.

Custom search engines take only a minute to set up and can save you ample time in the 
future.

The next time you start typing “fastcompany.com” into Chrome’s address bar, you’ll see in-
structions telling you to press Tab to search the site. Set up similar systems for shopping 
sites, Wikipedia, dictionaries and thesauruses, travel sites, or anything else you search 
semi-regularly, and you’ll save valuable time by skipping steps and jumping straight to 
the info you need.

13. Want to be able to search your email directly from Chrome’s address bar? Create a 
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new custom search engine with the name Gmail, whatever keyword you want (either 
“gmail.com” or some shortened command), and “https://mail.google.com/mail/ca/u/0/#-
search/%s” as the URL.

14. Search Google Drive from the address bar by creating a custom search engine with 
“https://drive.google.com/drive/u/0/search?q=%s” as the URL.

15. Speaking of Google Drive, if you move between multiple devices during the day (and 
at this point, who doesn’t?), make your life a little easier by telling Chrome to save any-
thing you download to a cloud-based folder. That way, you’ll be able to find important 
files from your desktop, laptop, smartphone, or any other device—regardless of where the 
download was actually performed.

First, you’ll have to install the desktop syncing program for your cloud storage service of 
choice. Most services, including Google Drive, Dropbox, and OneDrive, offer such utilities 
for all the common operating systems. Once you set up the program, you’ll have a folder 
on your local hard drive that’s always synced to a folder in your cloud storage.

Now, head into Chrome’s settings, click “Advanced,” and scroll down to the section labeled 
“Downloads.” Click the “Change” command and find or create an appropriate subfolder 
within your cloud-synced folder. Once you’ve followed those steps on any desktop com-
puters you want connected, anything you download will be available everywhere you 
work—and always accessible via the cloud service’s mobile apps as well.

TAKE ADVANTAGE OF HIDDEN POWER TOOLS

16. Quiet annoying sites once and for all by right-clicking their tabs (where the title is 
displayed) and selecting “Mute site.” This option will prevent the site from playing any 
audio on your computer anytime you visit it.

17. Prefer to avoid leaving a trail as you navigate the web? Open Chrome’s settings, click 
“Advanced,” and then turn on the toggle next to “Send a ‘Do Not Track’ request with your 
browsing traffic,” located within the “Privacy and security” section.

18. For additional privacy, take advantage of Chrome’s out-of-the-way option to create 
multiple user profiles and allow guest access to your browser. That’ll let someone else 
use Chrome on your computer without gaining access to all of your personal data (and 
without gunking up your history with whatever sites they visit). Look for the line labeled 
“Manage other people” in Chrome’s settings to get started.

19. Chrome’s History page—accessible by hitting Ctrl- or Cmd-H or by typing chrome://
history into your address bar—has a powerful yet easily overlooked feature: an al-
ways-synced list of tabs you have open in Chrome on other devices. Surf over there any-
time you want to find what you were last viewing on your phone, your tablet, or another 
computer.

20. The Back button in Chrome’s upper-left corner does more than you might think. Click 
it and hold your mouse’s button down, and you’ll get a pop-up history of recent pages 
viewed within your current tab.

FASTCOMPANY.COM  16

135 INCREDIBLY USEFUL THINGS     
 YOU DIDN’T K NO W GOOGLE COULD DO

27 INCREDIBLY USEFUL THINGS YOU DIDN’T KNOW CHROME COULD DO



21. Chrome can strip all formatting from copied text as you paste it—eliminating links, 
fonts, colors, and anything else you might not want to carry over. Once you’ve copied 
some text, hit Ctrl- or Cmd-Shift-V to give it a whirl.

22. Trying to look at a website that’s down—or need to step back in time and see how a 
particular page looked a while ago? Type cache:website.com into Chrome’s address bar, 
replacing website.com with whatever URL you want.

23. Let Chrome act as your file explorer: Drag and drop any image, video, or audio file into 
the browser to open it right then and there—and on Windows, try typing C:\ into Chrome’s 
address bar to browse your hard drive’s contents.

ENHANCE YOUR ENVIRONMENT AND ELIMINATE ANNOYANCES

24. Sick of getting those pop-ups asking if some site can send notifications through your 
browser? Turn off site notifications entirely by opening Chrome’s settings, clicking “Ad-
vanced,” then clicking the line labeled “Content settings.” Next, find and click the line for 
“Notifications” and turn the toggle at the top of the page off.

25. The next time you come across a text form on a website, give yourself a little space to 
think: Look for the two diagonal lines in the box’s lower-right corner. Click that area and 
drag downward, and ta-da: You can resize the text box to make it as large as you’d like.

Dragging down on the diagonal lines in a form’s lower-right corner lets you expand the 
box so you can actually see everything you’ve typed.

26. Chrome extensions can be incredibly useful, but they can also create a lot of clutter 
in your browser’s upper-right corner. Hide the extension icons you don’t need to see by 
right-clicking them and selecting “Hide in Chrome menu” from the options that appear. 
You can also just hover your mouse over the far right side of the address bar until you see 
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a double-sided arrow appear and then drag the address bar toward the right to extend it 
and hide multiple extension icons at once.

And if you ever need to get to an out-of-sight extension icon, just open the main Chrome 
menu (the three-dot icon to the right of the extensions). You’ll see all of the icons there.

27. While we’re talking about extensions, did you know you can create custom keyboard 
shortcuts for opening extensions on demand? Some extensions even allow you to create 
shortcuts for specific commands. Type chrome://extensions/shortcuts into your browser’s 
address bar to set up your own.
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When it comes to managing email, you need every advantage you can get.

Google recognizes this. The company has packed Gmail with dozens of advanced options 
that can save you time and add powerful possibilities into your inbox. The only problem 
is that there are so many of them—scattered across so many places—that it’s all too easy 
to overlook something useful.

Not to fear, though: I dug through every nook and cranny to uncover Gmail’s most valu-
able out-of-the-way settings. These next-level options go beyond the broadly known 
basics and have the potential to reshape how you handle your email. Some of them are 
specific to the new Gmail design, while others apply to both the new and classic versions 
of the site. (And most of them are relevant primarily for the desktop Gmail site, by the 
way—as opposed to the mobile apps—with just a couple of noted exceptions.)

So fire up your brain’s memory banks: It’s time to crank up your inbox IQ.

COMPOSING MESSAGES

1. Gmail’s new Smart Compose feature can save you precious time by predicting what 
you’re going to write before you write it—kind of like autocomplete for your inbox. It 
works surprisingly well, too, and it’s easy to ignore when its suggestions aren’t spot-on.

To try it out, you’ll first need to turn on the “Enable experimental access” option within 
the General tab of the new Gmail’s settings. After you click the “Save Changes” button at 
the bottom of the screen, Gmail will refresh itself—and Smart Compose should then auto-
matically be activated. You can confirm by going back into the General tab of the settings 
and looking for the newly added Smart Compose option. As long as “Writing suggestions 
on” is checked, you’re all set—and you should see Google’s predictive text show up period-
ically as you write new emails.

2. Speaking of saving time, do yourself a favor and head into the Advanced section of the 
new Gmail settings (or the Labs section in classic Gmail) and enable “Canned Respons-
es.” Once you do, you’ll be able to create simple templates that can then be inserted into 
messages with a couple of clicks.

3. Gmail’s snooze option is spectacular—but its default snooze times may or may not be 
ideal for your own personal schedule. Here’s a little secret, though: You can customize ex-
actly what time Gmail considers to be “morning,” “afternoon,” and “evening” by looking 
in the settings of Google Keep (obviously, right?). Just change the default times for each 
day-part within Keep’s settings, and the same times will then carry over to Gmail—both 
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on the website and within the mobile app.

4. By default, Gmail gives you a small window in the corner of the screen for compos-
ing new messages. If you’d rather write in a centered and more full-screen field, you can 
click the small diagonal arrow in the window’s upper-right corner to change its size and 
placement. And if you always want to write in a full-screen window, there’s a setting to 
adjust Gmail’s default behavior: Click the three-dot menu icon in the compose window, 
then select “Default to full-screen.” That’ll make all your future emails start in that large, 
centered view.

5. If you’re anything like me, you probably archive messages immediately after respond-
ing more often than not. Save yourself a step and switch on Gmail’s optional “Send & Ar-
chive” button, which combines sending and archiving into a single command. (It doesn’t 
replace the regular “Send” button; it just appears as an extra button alongside it.)

You can activate it by looking for the “Send and Archive” option in the General section 
of Gmail’s settings. Select “Show ‘Send & Archive’ button in reply” and then hit the “Save 
Changes” button at the bottom of the page.

6. Gmail’s “Undo Send” feature can be a real lifesaver, but its default cancellation window 
of five measly seconds doesn’t give you much time to change your mind. Head into the 
General section of Gmail’s settings and click the dropdown box next to the “Undo Send” 
option. You can bump the value up to 10, 20, or even 30 seconds—which means that you 
can give yourself up to half a minute to have second thoughts about any message you 
send.

READING YOUR MAIL

7. Not a fan of Gmail’s tabbed inbox? Hover your mouse over “Inbox” in the left sidebar 
and click the downward-facing arrow that appears alongside it. That’ll let you choose 
from five different inbox configurations: “Default,” which is the standard tabbed set-
up; “Important first,” which splits your inbox in half, with messages Google deems to 
be important on top; “Unread first,” which does the same thing but with unread mes-
sages taking up the upper portion of the screen; “Starred first,” which does exactly what 
you’d think; and “Priority Inbox,” which lets you create up to four customizable sections 
to break apart different types of messages.

8. If you’re using the default tabbed inbox configuration, take control of how it works by 
looking in the Inbox section of Gmail’s settings. There, you can simplify things a bit by de-
activating tabs you don’t want displayed (which causes messages that would have been 
categorized within them to go into the next most appropriate tab). You can also activate 
a handy option to have any messages you star always show up in your “Primary” tab, 
regardless of where they were initially sorted.

9. If “Priority Inbox” is your cup of tea, head into that same Inbox section of Gmail’s set-
tings to configure your inbox sections in any way your heart desires. The possibilities 
there are practically endless.

10. Regardless of which inbox setup you choose, be sure to experiment with Gmail’s den-
sity modes to find the inbox display style that works best for you. Click the gear icon in 
the site’s upper-right corner. In classic Gmail, you’ll see options for “Comfortable,” “Cozy,” 
or “Compact” density right in that main menu; in the new Gmail, you’ll first need to select 
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“Display density” and will then see options for “Default,” “Comfortable,” and “Compact.” 
Note that “Default” puts the newly added attachment previews into your inbox view, 
while “Comfortable” and “Compact” hide that information.

11. Miss Outlook’s preview pane, where you can read a message while still keeping your 
inbox in view? Gmail actually offers a similar view that shows everything at once. Look 
in the Labs section of classic Gmail’s settings or the Advanced section of the new Gmail’s 
settings and enable the option labeled “Preview Pane.” That’ll put a new four-line icon 
next to the settings button in the top-right area of your inbox. Click the downward-facing 
arrow next to it, and you can opt to have either a vertical split—in which any message you 
select appears to the right of your inbox—or a horizontal split, in which message previews 
appear beneath your inbox.

Be sure to look in the General section of Gmail’s settings, too, as an option there labeled 
“Preview Pane” will let you control how long you can keep a message open in the pane 
before it gets marked as read.

12. Let’s not kid ourselves: No one likes pagination. Meander back into the General section 
of Gmail’s settings and look for the “Maximum page size option.” You can’t turn off pag-
ination completely, but you can show up to 100 conversations at a time—and if you have 
more than that many items still in your inbox, pal, you’ve got bigger problems.

OPTIMIZING AND ORGANIZING

13. Gmail’s stars provide a great system for marking important messages—so why not 
take things up a notch and give yourself even more ways to designate attention-demand-
ing threads? The “Stars” line the General section of Gmail’s settings lets you add up to 
11 additional icons into your list of message-starring possibilities, with options ranging 
from differently colored stars to exclamation point, question mark, and check mark sym-
bols.

Just drag and drop whatever icons you want into the “In use” list, and pay careful atten-
tion to the order: It’s the same order in which the icons will be applied—so if you put a pur-
ple star in the second position and an exclamation point in the third, clicking a message’s 
star field twice would assign the purple star to it, while clicking it three times would give 
it the exclamation point.

14. Make your inbox more effective by clearing out clutter and leaving only the labels you 
need. In the “Labels” section of Gmail’s settings, you’ll find commands to hide any label 
or category you don’t regularly access from the label list—that long and often sprawling 
list in your inbox’s left sidebar. You’ll still be able to get to those hidden labels; they’ll just 
be tucked away beneath the “More” option and thus out of your way most of the time, so 
you can more easily focus and find the ones you use the most.

15. The Tasks app associated with the new Gmail isn’t integrated into the Google ecosys-
tem terribly well as of now, but you can connect your tasks with your Google Calendar—if 
you know how: Open up the Google Calendar website. See the “My calendars” section on 
the left side of the screen? You should see an option within it labeled “Reminders.”

Tap the three-dot menu icon alongside that line and select “Switch to Tasks.” Any tasks to 
which you assign a date within the Gmail Tasks sidebar or the standalone Tasks mobile 
app will now automatically appear in your calendar. Just note that this feature replaces 
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the integration of regular Google reminders created via Assistant, Keep, or the Google 
search box.

16. You probably know about Gmail’s keyboard shortcuts, right? (If you don’t, go activate 
them—right now—in the General section of Gmail’s settings.) You might not know, how-
ever, that you can create your own custom keyboard shortcuts, too: Look in the Labs sec-
tion of classic Gmail or the Advanced section of the new Gmail to fire up the option, then 
look for a new Keyboard Shortcuts section in your settings.

There, you can change any of the default keyboard shortcuts or supplement them with 
secondary options. One super-useful adjustment I enjoy—inspired by Google Inbox—is 
adding the simple shortcut “i” as a faster way to jump directly from anywhere to my in-
box.

17. Whether it’s Uncle Geoffrey or the mailing list that just won’t quit, there’s always some 
irritating force that consistently fills your inbox with irrelevant garbage. Gmail has a bur-
ied setting to get annoying missives permanently out of your hair: While viewing a mes-
sage, click the three-dot menu icon in its upper-right corner (directly to the right of the 
reply icon), then select the “Block” option. Any emails from that address will automatical-
ly go right into your spam folder from then on—and if you ever have second thoughts, you 
can manage your list of blocked addresses in the Filters and Blocked Addresses section 
of Gmail’s settings.

18. Using the new Gmail? Take a moment to set up its offline mode before you actually 
need it. Unlike the clunky offline option in the classic version of Gmail, this offline mode 
works just like the regular Gmail website; all you have to do is open the site before you 
lose your connection. As long as you’re using Chrome 61 or higher, you’ll then be able to 
look through your messages and compose new emails as if you were online, no Wi-Fi 
necessary. (Any emails you compose while offline will be kept in a new Outbox folder and 
then sent as soon as you reconnect.)

The option resides in the aptly named Offline section of the new Gmail’s settings. Set it 
up the way that makes sense for you, be sure to hit “Save”—and then rest easy knowing 
that the next time your internet connection wavers, all your email will still be right there 
and waiting.
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When you’re working in a word processor, every second you save matters. And while Goo-
gle Docs may seem simple on the surface, it’s practically overflowing with out-of-sight 
options that can help you get more done with less effort.

The best part? They’re all already there and just waiting to be embraced. All you have to do 
is find them–and then remember to put them to use. Here’s a head start.

(Note that the items listed below are mostly specific to Docs’s version for desktop web 
browsers. Unless otherwise noted, they don’t apply to the mobile apps.)

EDIT LIKE A PRO

1. The next time you need to move text within a document, skip the cutting and pasting 
and shift text the faster way: Just highlight the paragraph you want to reposition and then 
click and drag it with your mouse–or, in an even more efficient twist, place your cursor 
anywhere inside the paragraph, hold down Alt and Shift together, and then use your ar-
row keys to move it wherever you want.

2. Need your text to be a little larger or smaller? Docs has a pair of super-handy shortcuts 
that’ll change font size on the fly: Hold down Ctrl (or Cmd) and Shift and then press the 
period key to bump the font size up by one point or the comma key to bump it down.

3. With just a few quick clicks, Docs can copy the formatting from one area of text and 
apply it to another. The trick lies within that paint roller icon in the upper-left corner of 
the Docs toolbar (directly to the right of the print icon). Place your cursor on the text that 
has the formatting you want, click the paint roller, and then click the paragraph where 
you want the formatting to be applied. The font, size, style, and color should all show up 
instantly.

If you want to apply the formatting to more than one area of text, double-click the paint 
roller at the start of the process. That’ll force it to remain active through numerous appli-
cations.

4. Save yourself the trouble of digging through Docs’s menus to find what you need and 
instead use the Alt-/ shortcut to search all available functions in no time. Say you want to 
convert some text into title case, for instance. Rather than digging around in the Format 
menu, you can simply highlight the text in question, hit Alt and then /, type “ti”–and 
then, when “Title Case” appears as the top option, hit Enter to apply it.

5. Docs can automatically organize your documents to make them easier to get around: 
Open up the View menu and select “Show document outline”–or just hit Ctrl-Alt-H (or 
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Cmd-Alt-H)–and the app will create a complete outline in the left area of the screen, with 
every line of header text representing a section. You can then click on any of those sec-
tions to jump directly to that part of the document. (This one is also available in the Docs 
mobile apps; just look for the “Document outline” option in the apps’ main menu.)

6. Give your fingers a break and let Docs turn your spoken words into text: As long as your 
computer has a microphone, all you have to do is open the Tools menu and select “Voice 
typing”–or hit Ctrl-Shift-S (or Cmd-Shift-S)–and then speak away. Docs will use Google’s 
standard voice-to-text system to figure out what you’re saying (mostly, anyway) and put 
it on the page.

7. Docs’s voice-to-text function also lets you speak commands for common forms of punc-
tuation and paragraph formatting. You can say things like “period,” “comma,” and “ques-
tion mark” or give instructions like “new line” or “new paragraph.” If you want to take a 
break, say “stop listening” and then say “resume” when you’re ready to continue.

8. In addition to taking down text, Docs’s voice typing mode allows you to perform ad-
vanced edits via spoken command. The system supports a huge range of functions–se-
lecting specific words, phrases, or paragraphs; applying different types of formatting to 
text; cutting, copying, and pasting; and even scrolling through a document or jumping to 
specific parts of the page. You can find a full list of available commands here.

9. Docs’s dictation feature is good for more than just regular writing and editing: Any-
time you have some audio that needs to be turned into text–from a recorded interview, a 
podcast, or whatever the case may be–find a quiet room for your computer, fire up Docs’s 
voice typing mode, and let the audio play. Docs will provide a full transcription of your 
recorded audio, no specialty services or fees required.

ENRICH YOUR DOCUMENTS

10. Docs makes it possible to do all of your research without ever leaving your word pro-
cessor–both on the desktop and from your mobile device. Open up Docs’s Explore tool by 
looking in the Explore menu (or pressing Ctrl-Alt-Shift-I or Cmd-Alt-Shift-I) on the desk-
top site or by finding the “Explore” option in the mobile apps’ main menu (while you’re 
actually editing a document). Docs will bring up a series of web results, images, and re-
lated documents from your own past work. You can perform new searches right within 
that window as well–and when you find something you’d like to include in your current 
document, you can add it and even attach a footnote citation with a single click or tap.

11. Attention, Google Photos users: Docs makes it easy as can be to add images from your 
Photos collection directly into your documents. Click the Insert menu and select “Image” 
to find the option. You can also add an image from your Google Drive storage, by URL, or 
by searching the web from that same area.

12. Docs has its own tool to let you crop or edit images: Just click on an image within your 
document, then click the Format menu and select “Image.” There, you’ll find the com-
mand for cropping as well as a broader “Image Options” selection that contains functions 
for recoloring and adjusting the image’s transparency, brightness, and contrast.

13. Not confident about a word’s meaning? Hit Ctrl-Shift-Y (or Cmd-Shift-Y) while your 
cursor’s on the word. Docs will dig up a definition for you and show it to you on the right 
side of the screen.
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14. If you use Google Keep as a note-taker, you can access your notes while working on a 
document and even insert an entire note into your current page. Look for the “Keep note-
pad” option within the Tools menu to pull up the Keep sidebar. Once it’s there, you can 
view and edit your notes–and if you want to dump a note’s contents in your document, 
hover over the note and then click the three-dot menu icon that appears.

COLL ABORATE AND SHARE

15. Don’t let a language barrier keep you from communicating. Docs has a native system 
that can translate entire documents into other languages: Click the Tools menu, then se-
lect “Translate document.” You’ll then be able to select the language you want and pro-
vide a new name for your translated file. Fácil, ¿no?

16. You’d never know it, but Google Docs allows you to tag other users to get their atten-
tion while collaborating. Just start writing a comment–by clicking the circular icon that 
appears when you hover over the right side of a document on the desktop or by tapping 
the plus icon and then selecting “Comment” in the mobile app–and then type @ or + 
followed by the first few letters of a person’s name. Docs will start offering options from 
your Google Contacts list. And if you want to add someone who isn’t in your contacts list, 
just use an email address instead of a name.

If the person you select already has access to the document, they’ll receive an email noti-
fying them of the mention. If they don’t, Docs will prompt you to share the document with 
them before proceeding.

17. You can also email any message you want to collaborators, along with an attachment 
of a document, directly from Docs. Look for the “Email collaborators” option in the File 
menu to get started. (Your message will come from the primary email address associated 
with your Google account.)

18. Maybe you want to send a copy of your document to someone via email without add-
ing them as a collaborator–to provide the file to a client, for instance, or share it with 
someone outside of your organization for review. Docs can do that: Just open up the File 
menu and select “Email as attachment.” You’ll be able to select from a variety of formats 
or even opt to include the text within the email body.

19. Docs can turn any document into a live, functioning web page that you can then share 
or embed as you wish. See the “Publish on the web” option within the File menu to ex-
plore the possibility.

20. If you want to point people to a specific section of your document, use Docs’s book-
marking feature to create a direct link to any area of the text. Place your cursor where you 
want the link to reside, then open the Insert menu and select “Bookmark.” A pop-up will 
appear with the link, though you’ll still need to be sure to share the document appropri-
ately (either with the people you want to be able to view it or publicly, if you want every-
one to be able to access it) before it’ll work for anyone other than you.

21. Want to send someone a link to a PDF version of your document? Copy the full URL in 
your browser’s address bar while you’re editing the document, then change the “/edit” at 
the very end to “/export?format=pdf” (without the quotation marks). As long as people to 
whom you’re sending have access to the document, they’ll get a PDF of your work as soon 
as they open the link.
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22. You can use a similar trick to turn your document into a template for other people’s 
ongoing use: Once again, copy the full URL in your browser’s address bar while you’re ed-
iting the document—but this time, change the “/edit” at the end to “/copy” (again, without 
the quotation marks). Send that link to anyone with whom you’ve shared the file, and 
when they open it, they’ll be prompted to make a copy in their own Docs storage and then 
work on it from there.

EXPAND YOUR WORD PROCESSING HORIZONS

23. Google Docs can give you a helping hand with design by way of its built-in template 
gallery: Open up the gallery to browse through the available options–ranging from ré-
sumés to project proposals and even some advanced business and legal document for-
mats–and then select any item to open it in Docs and use it as a starting point.

24. Start a new document from anywhere within your browser by adding docs.google.
com/create as a bookmark and then placing it in your bookmarks bar–or creating a cus-
tom keyboard shortcut that’ll pull the link up on demand.

25. Don’t limit yourself to Docs’s list of default fonts. You can add dozens of fonts into your 
word processing setup–and once they’re added, they’ll always be available in the regular 
font dropdown menu. All you have to do is open that dropdown menu and look for the 
“More fonts” option at the top. Click it and browse or search Google’s web font archive to 
find the style that meets your needs–then write away with the right look for every project 
you tackle.
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Google Maps is great for just getting around. But don’t be fooled: The app is much more 
than a glorified Garmin. Maps has all sorts of powerful features and time-saving short-
cuts that aren’t obvious, but are just waiting to be discovered. So grab your compass and 
get ready: It’s time to explore some of its most useful off-the-beaten-path options.

1 .  GO COMPLETELY HANDS-FREE

We’ve all been guilty of glancing down at our devices while driving—to look ahead at the 
next turn, perhaps, or see how long is left in a commute. If you have an Android phone, 
there’s a better way: Google Maps has a whole series of helpful voice commands that’ll 
work whenever you’re actively navigating.

Just say “Okay, Google” and then try variations on these examples:

“What road is this?”

“What’s my next turn?”

“What’s my ETA?”

“How’s traffic ahead?”

“How’s traffic to work?”

“Avoid tolls”

“Avoid highways”

“Find gas stations”

“Find restaurants”

“Navigate home”

“Take me to McDonald’s”

“What’s the closest hotel?”

“Exit navigation”

You can also instruct your phone to make calls, send texts, play music, or look for your 
next appointment—all without ever taking your eyes off the road.

2.  REMEMBER WHERE YOU PARKED

Open up Maps on your iPhone or Android phone and tap the little blue dot that represents 
your current location. That’ll pull up a hidden menu with some handy options—includ-
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ing the ability to save your current parking location. You can add in your own supplemen-
tary notes or photos and even set a timer to remind you when it’s time to move your car.

Everything you need to remember where you parked is right within the Maps mobile app.

When you’re ready to get back to your spot, look for the saved parking notification on 
your phone or just open up Maps and tap the “Parking location” card at the bottom of the 
screen.

3.  SHARE YOUR LOCATION, EVEN AS YOU MOVE

Need someone to find you—or maybe just know where you are? Take a look at Maps’ sim-
ple system for real-time location sharing.

To try it, open up Maps on your phone and tap the blue dot, just like in the previous tip, 
but this time, select, “Share your location.” You’ll be able to set an end time for the loca-
tion sharing or opt to keep it active until you manually turn it off. You can then select any 
of your contacts to share with or get a private web link to paste wherever you want.

You can also access the sharing function while in the midst of a Maps navigation by 
swiping up from the white bar at the bottom of the screen and then selecting “Share trip 
progress.” That’ll share your location with whomever you choose until you reach your set 
destination.

In either scenario, anyone who opens the link will see an icon showing your current posi-
tion on a map as you move—within the Maps app, if they have it, or in a regular browser 
window if they don’t. You’ll see an indicator at the bottom of Maps letting you know loca-
tion sharing is active, and you can always stop the sharing by tapping that box.

4. SEARCH ALONG YOUR ROUTE WHILE NAVIGATING

That swipe-up-while-navigating menu mentioned in the previous tip has one other use-
ful gem: an option to search along your current route.

Activating it will give you one-tap buttons for finding gas stations, restaurants, grocery 
stores, or coffee shops along your way from point A to point B. You can also type in your 
own custom search term—if, say, you want to see every Starbucks or Taco Bell that’s on 
your present path.

5.  FIND OUT WHAT ’S NEAR ANY THING

A similar sort of search is available in Maps, even when you aren’t navigating. Any time 
you want to find specific types of places near your current location or any other spot, tap 
the search bar at the top of the mobile app and try variations on these queries:

“Restaurants near here”

“Pharmacies near Figueroa and 1st Street”

“Vegetarian restaurants near me”

“Book stores near UCLA”

“Gas stations near the airport”

“Things to do near the Florida Theatre”
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Maps can act as your guide to practically anything, anywhere.

You can also browse to see what’s near your current location by opening Maps on your 
phone, and then scrolling and swiping through the Explore tab at the bottom of the 
screen.

6. EXPLORE AT EYE LEVEL

Street View is one of Maps’ coolest features, but you’d probably never even realize it exist-
ed if you didn’t know where to look.

First, on your phone, search within Maps for any location—like Times Square, for in-
stance. (You can also touch and hold your finger to any spot on a map to select a specific 
point of reference.) Next, tap the image of the location that appears in the lower-left cor-
ner of your screen.

Now, for the really neat part, tap the compass icon in the app’s upper-right corner. Hold 
your phone up and move it around, and the view will shift to match the actual direction 
you’re facing at any given moment. It’ll be like you’re standing inside the map and looking 
around.

7.  GO BACK IN TIME

Fire up the flux capacitor, Doc, ’cause we’re about to do some serious time traveling. Goo-
gle Maps has a little-known feature that lets you look at the Street View for any area as it 
existed at various points in the past.

This one only works from the desktop site, so open up Maps on your computer and pick 
a place. See that little yellow guy in the lower-right corner—known to his friends as Peg-
man? Drag him up with your mouse and drop him wherever you want to go. Then look for 
the clock icon in the gray box at the top-left of the screen.

Tap that, and you’ll be able to drag a slider back through time to see 360-degree views 
from previous years. The feature isn’t available for every possible place, but it’s pretty 
widespread—and a lot of locations have a full decade’s worth of data.

8.  BEAM A MAP DIRECTLY TO YOUR PHONE OR CAR

Speaking of Maps on the web, the next time you’re looking up directions on your desktop, 
save yourself a step and beam them directly to your vehicle or mobile device.

All you need to do is click an inconspicuous option that appears whenever you search for 
a place or pull up directions. It’ll be in the box on the left side of the screen—either as an 
icon beneath the place’s name or address, if you’re looking at a regular map, or as a plain-
text link immediately above the route options, if you’ve already pulled up directions. (If 
you’ve clicked through to a specific route, it’ll be an unlabeled icon immediately to the 
right of the travel time estimate. And yes, there’s some irony in the fact that you practical-
ly need a map to find this feature.)

Click whichever version appears, and you’ll see a list of devices that are connected to your 
Google account. Android devices should show up automatically, while iPhones will re-
quire you to first install and sign into the Maps app and then enable notifications within 
the app’s settings. For a car, you’ll have to manually add your vehicle on Google’s Send to 
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Car site, provided you have a compatible make and model.

Whichever way you go, the Maps info will show up as a notification on your dashboard or 
device seconds after you send it over from your desktop.

9. SEE TIME-SPECIFIC TRAFFIC ESTIMATIONS

You can find out how long a drive is likely to take at any given time with Maps’ intelligent 
traffic estimation tool. Just search for a location in Maps’ desktop version, then click the 
“Directions” button and put in whatever starting point you want.

At the bottom of the same box where you typed the address, you’ll see a line that says 
“Leave now.” Click the downward-facing arrow next to that, then select either “Depart 
at” or “Arrive by” to view the probable traffic conditions and estimated trip total for any 
specific day and time.

Maps’ traffic estimation tool will help you figure out how much time you need to leave for 
a drive, even if you aren’t hitting the road right away.

10.  ADD EXTRA DESTINATIONS INTO YOUR DIRECTIONS

Not every trek is a two-stop adventure—and while it isn’t exactly front and center, Maps 
has a feature that lets you add multiple stops into any navigation.

From your phone, start by searching for your first destination. Tap the “Directions” but-
ton, then type in your starting point. See the little three-dot menu icon to the right of that 
same field? Tap it, then select “Add stop” from the menu that appears. You’ll then get a 
third field in which you can enter another destination—and when you fill that one in, the 
option for a fourth destination will appear. You can even drag and drop the destinations 
to reorder them as needed.

The feature’s a little more prominent when using Maps on a computer: After firing up 
directions to a specific destination, you’ll see a small plus sign with the text “Add desti-
nation” alongside it. You can tap that to add as many extra stops as needed into your trip, 
and you can drag and drop destinations with your mouse to change their order.

11. MEASURE THE DISTANCE BETWEEN MULTIPLE POINTS

Want to map out your morning jog—or maybe just know exactly how far you have to trav-
el on a particular trip? Maps can precisely measure the distance between two or more 
points, all the way down to the second decimal.

On your phone, tap and hold your finger on your starting point. That’ll cause a red pin to 
appear along with a white bar showing more info about the location. Swipe up on the bar 
and select the “Measure distance” option, then use your finger and the blue plus icon to 
find and select the second point. Repeat as many times as needed to measure your full 
path.

Maps’ distance-measuring feature makes it easy to figure out the precise distance be-
tween any number of points.

On a computer, right-click on your starting point and select “Measure distance” from the 
menu that appears, then click on each subsequent point in your path to get measure-
ments.
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12.  SAVE TIME WITH ADVANCED GESTURES

You probably know all about pinching to zoom, but Maps has a bunch of other useful 
gestures to help you get around the app on your mobile device. Try out these advanced 
manuevers:

To zoom in or out of a Map with a single hand, double-tap and then—without lifting your 
finger—slide up or down on the screen.

Spin a map around to change your orientation by placing your index finger and thumb 
on the screen and then twisting them together to the left or right.

Shift your perspective by placing two fingers on a map and sliding them both upward on 
the screen. That’ll take you into a “flyover” view of whatever area you’re looking at, com-
plete with three-dimensional buildings in a lot of places.

Want to save a step the next time you’re ready to navigate? After you look up a location, 
press and hold the blue “Directions” button at the bottom of the screen. That’ll take you 
directly into navigation mode, using Google’s best guess for the route and method of 
transportation you’re likely to use.
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